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Preface

BlenderCourse teaches you about 3D modelling and provides you short tutorials about a
specific subject. The main thought is: Just do it! During different courses you learn
various techniques. If necessary there is a small instruction, but in my opinion you learn
best when doing the exercise by yourself.

BlenderCourse is intended for everyone who can use a computer. This means you
understand terms as “double click” and “tab-key”.

You do not need any 3D-modelling knowledge; the terms used will be explained during
the different courses.

If you see an error or something is not clear, I want to ask you to contact me through
feedback@blendercourse.com. More Blender Course material can be found at
http://www.blendercourse.com.

I would like to thank Erik van der Kouwe for correcting this document.
Have fun with Blender Course!
Bas van Dijk

Wijdewormer, the Netherlands, November 2006



Introduction

During these lessons we are using the 3D modelling tool Blender 3D, but what is this for
kind of tool? With Blender you can create 2D- and 3D-images and it is possible to make
animations/movies.

The “Appendix 4 - Blender gallery” is a small showcase about the possibilities of Blender.
Before you can start with a lesson you first have to read small a piece of text which
describes the techniques of the lesson. At the end of every lesson is an image of "The
challenge”. The idea is that you can reproduce the image by using the techniques learned
during the lesson. The last two chapters do not have a challenge because these are about
animation.

All Blender files are provided with this BlenderCourse. You can find these in the “Course
Material” folder.

This document is using several symbols. Below is the explanation of these symbols:
= An arrow (=) means instruction. This means you have to follow the step after it.

Example: 2> Click with the right mouse button on the object.

= A text between < and > means a key on the keyboard.

Example: Press <Enter> to confirm the operation.

= A combination of more than one key will be written with the plus sign (+).

Example: Press <Alt> + <F4> to exit the program.

= A button on the screen will be written between [ and ].
Example: Click at [OK] to close the window.

= If there is an arrow (=) between two words, this means a click sequence in a
menu.

Example: Choose File > Save

= A new technique or additional information will be written inside a grey box.

Example:

This is how this technique works.
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Results per Course

Below are all the results from the different exercises in this BlenderCourse.

Course 1 — Mesh en vertex editing 1

House

Course 2 — Mesh en vertex editing I1

Pill

Course 3 — Render options en Proportional Editing

Mountain scenery

BlenderCourse - Basics v0.2.2
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Course 4 - Curves
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Chair

Course 5 — Materials en light

Transparent spheres Wireframe
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Marble texture Emitting Marble texture

Spotlight 7 Red Halo
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Course 1 - Mesh en vertex editing I

For all lessons in BlenderCourse it is assumed that you have installed Blender (Appendix
1 - The installation of Blender) and configured according to “"Appendix 2 - Configure
Blender”. If have not done this already please do so.

Meshes and vertices

A 3D-object, like a cube, sphere or cylinder is called a mesh (figure 1). This cube
consists of eight points. One of these points is called a vertex (plural vertices) they are
red marked in figure 2.

figure 1 figure 2

In case of the cube four vertices make a face. Each face has a minimum of three
vertices.

Views and axis

In 3D space we are using three axis: X-, Y- and Z-axis. In the bottom left of each view
(marked red in figure 3) is shown in which direction these axis are pointing. Figure three
is a screenshot of the front-view. Here you can see that the Z-axis is the vertical one and
the X-axis the horizontal one.

{13 Cube

figure 3

Rendering

In Blender we are working with some kind of wireframe (figure 4). This wireframe is not
the actual result of your design (figure 5). The wireframe needs to be “translated” into an
image, this process is called rendering. During this process the CPU calculates things like
light, shadow, reflections etc.

figure 4 figure 5

BlenderCourse - Basics v0.2.2 8



A house

During this lesson we are going to build a simple house as shown in figure 19. There is a
image below (figure 6) to remind you about the names of the different views.

[§ ]~ File Add Timeline Game Render Help []SR2-Model [X] [ =]SCE:Scene [X &) Ve8| FaB|Ob:3-1|Lat |Mem:1.59M | Time: | Cube

3 [ Centre New_|
wertCal

o
ce
TexFacel Make |
TH (et Smooth [ SetSoid | Stcky FasterDra o . Normal Fi

figure 6

= Start Blender.

= Move with your mouse cursor to the centre of the cube in the “Front View” and
click with your right mouse button to select.

In the bottom left of the view you can see which object you have selected (marked in red
in figure 7).

1) Cube

HE sl = wria
figure 7

The horizontal line in the Front View is the 0-line. The cube is located half below this 0-
line. The next steps show you how to move the cube upwards.

= Move with the mouse cursor to the centre in the Front View and press <G>

(move), you can now move the cube (move the mouse around and see what the
result is in the other views).

= Press <Esc> to cancel the movement; the cube is placed back to its original
location.

You can see moving a cube around is not easy. You can define the axis where the object

needs to move along. In order to do this press <G> and the letter of the axis which you
like to lock (<X>, <Y> or <Z>).

If you hold down <Ctrl> during the movement you make sure the object moves along
the grid.

BlenderCourse - Basics v0.2.2



= Move back with your cursor in the centre of the cube in the Front View and press
<G> for move and <Z> to lock the Z-axis.

You can now see the axis which you have locked, in this case the light blue Z-axis (figure
8).

D: 0.0000 (0.0000) along global 2

= T T = o 1

figure 8

= Now hold <Ctrl> down while moving the cube upwards till it is on the 0-line.
= Click with your left mouse button or press <Enter> to confirm the movement.

If everything worked out well you screen should look like figure 9.

~ View Seleot _Object &0 = [soa =] FHEHHHHIA
o} |

[ select ot TR ]e [covn =) AL LI LTI
=4 = punen [olelofeMlal [ 1 ]
figure 9

This cube is the basis of our house, we only need the roof. In order to build the roof we
need another cube on top. To achieve this we are about to duplicate the old one.

= Select in the Front View the cube (move cursor to the centre of the cube and
press the right mouse button).

= Press <Shift> + <D> (duplicate object).
You can now move the duplicated cube freely around.
= Press <Z> to lock the Z-axis.
= Hold down <Ctrl> and move the cube till it is on top of the first one.

= Click with the left mouse button or press <Enter> to confirm the movement.

If everything worked out well you now have two cubes as shown in figure 10.

BlenderCourse - Basics v0.2.2 10
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v Wiew Select Object | % Object Mode = E_@ o |Global = EH:H:H
figure 10

The cubes fall almost out of sight. If you use the scroll wheel (<Scrl>) when holding
<Ctrl>, <Alt> of <Shift> you can change this. This only applies to the view in which you
are currently working.

<Alt> + <Scrl> = Zoom view in and out
<Ctrl> + <Scrl> = Move view horizontal
<Shift> + <Scrl> = Move view vertical

= Move your cursor in the Front View and hold <Shift> while moving the scroll
wheel downwards till the cubes are in the middle of your view (figure 11).

[ = view Select Object [ Object Moe 2| (€3] (@ =] [BI&T0 [a [Giovar =] FHHHHHH
figure 11

Blender uses two different modes: Object Mode and Edit Mode. In Object Mode you are
working with the object as a whole. In Edit Mode you can edit the object per vertex or
muliple vertices.

You can switch between these modes by pressing <Tab>.
= In the Front View select the top cube.

= Press <Tab> for switching into Edit Mode.

You have now switched into Edit Mode. You can know this because of all the visible
vertices and the text “Edit Mode” in the view menu bar (red marked figure 12).

BlenderCourse - Basics v0.2.2 11
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| ——
figure 12

In the next steps we are going to make the roof sharp.
2 Press <A> to deselect all vertices.

= Press <B> for block selection and drag a rectangle around the topmost two
vertices (figure 13).

][9] (@ ] [O80s [owa_:][@ ] B [7[5] (@

ﬁgﬁre 13

You can scale objects by pressing <S>, to rotate you can press <R>. Also with these
operations you can use <X>, <Y> and <Z> to lock the axes.

= Move your cursor in a corner of the Top View (top left) and press <S> followed by
<X> to lock the X-axis. If we did not lock on the X-axis we would have a pyramid.

= Move your cursor to the centre of the view till the roof is getting sharp.
= Confirm your operation by pressing the left mouse button or press <Enter>.

If everything worked out well, you now have a house with a sharp roof just as (figure
14).

BlenderCourse - Basics v0.2.2 12
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figure 14

As you can see the house falls partly out of the camera view (bottom right). We are
going to correct this.

= Press <Tab> to switch back to Object Mode.

= Select (with the right mouse button) the camera in the Front View (marked red in
figure 14). Its colour changes to purple.

= Press <G> followed by <Z> and move the camera upwards till the whole house
shows up in the Camera View.

= Confirm your movement by pressing the left mouse button or press <Enter>.

You screen should now look like figure 15.

et [t ovpect usce =) [0 (@ =] IS0 [o [aiova <]

figure 15

BlenderCourse - Basics v0.2.2 13



It is time to save our work.

In Blender you can save by pressing <Ctrl> + <W> or choose File > Save. The first time
Blender prompts you for a filename, every next time your file is overwritten
automatically.

= Move you cursor in the Front View and press <Ctrl> + <W>.

The Front View changes into a save dialog (figure 16).

Load Ul
figure 16

= Change untitled.blend into bc01.01.blend and press <Enter>.

With the button marked in figure 17, you can change the drive letter.

CAProgram Files\Blender FoundatiomiBlandery hlender

figure 17

= Browse to the folder in which you like to save your file and press [Save File].

Your file is saved; you can see this in the window title of Blender (figure 18). This is the
filename in which your file is saved.

© Blender [C:\Program Files\Blender Foundation\Blender\.blender\bc01.01.blend]

i [[scR2-Mosel _|:
figure 18

Finally we are about to “render” our house. As described earlier, this operation
transforms our wireframe into the final image.

= Press <F10> to open the Render Panel (figure 19).

¥ Anim ¥ Format

b L
WTSC

AMIM

Default |
Do S__gg‘ugnc.:e | 1 Freview |
Do Composite i

figure 19

BlenderCourse - Basics v0.2.2 14



= Press [Render] or <F12> to start the rendering process.
A window appears, which shows the rendering process (figure 20).

-2 Blender:Render =10l x|

Fra:l “e:l6 Fad2 La: Mem:10.320 (000K ) Time:00.03.23

figure 20

The challenge

70 Blender-Render (=] 3]

figure 21 - castle — bc01.02.blend

BlenderCourse - Basics v0.2.2 15
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Skills from this course

= Moving, rotating and scaling objects
= Locking axis

= Editing vertices of an object

= Duplicating objects

= Saving files

= Rendering scenes

BlenderCourse - Basics v0.2.2
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Course 2 - Mesh and vertex editing 11

In this course we are continuing with editing meshes and also learn some Blender
meshes.

Basic meshes

Before you start drawing your 3D-model, you need to check of which basic meshes your
object consists. In the previous assignment our basic mesh was the “cube”.

Blender contains the following basic meshes: Plane, Cube, Circle, UVSphere, Icosphere,
Cylinder, Tube, Cone, Grid and Monkey.

Figure 1 shows all the rendarable meshes. A circle for example is not visible when
rendering.

The mesh Monkey is the mascotte of Blender and is named Suzanna. You can use this
mesh as a ready-to-use mesh.

Plane Cube UVSphere IcoSphere Tube
Cylinder Cone Monkey Grid
figure 1
Pill

In this chapter we are about to make a pill (figure 2).

figure 2

The First question we can ask ourselves could be: which basic meshes are we going to
use for making this pill? The most logical answer would be a Cylinder with two UVSpheres
on the end. Instead we are going to use only one mesh: the UVSphere.

BlenderCourse - Basics v0.2.2 17
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= Start Blender.

= Choose File > New (figure 3).

© Blender
Add  Timeline Game Render He

|1 ~GE

figure 3
= Click with the right mouse button on the cube to select.
= Press <X> to delete the cube.

A menu appears (figure 4).

figure 4

= Choose [Erase Selected].

The cube is deleted now.
= Move the mouse cursor to the centre of the Top View.
= Press <Spacebar>.

A menu appears.

= Choose Add > Mesh - UVsphere (figure 5).

Edit 4 Curve

Select 4 Surface

Transfarm » heta Uvsphere
Ohject 4 Text Icosphere

Wi Empty Cylinder
Tube

Cone

»
Render 2 Group

Camera

Lamp Grid
Armature
Lattice

BLY LY P - ’EI
figure 5

A prompt appears asking you the number of segments and rings.

= Press <Enter> twice to confirm the standard number of segments and rings.

You have now added a sphere to your scene (figure 6). We are now going to make a half

of the pill.

BlenderCourse - Basics v0.2.2
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figure 6

You have been switched into Edit Mode automatically and can see the yellow vertices of
the sphere.

Working in just a quarter of the screen is sometimes not practical. You can maximize a
view by moving your cursor into a view and press <Ctrl> + <A>. With <Ctrl> + <>
you are switch back.

= Maximize your Front View by pressing <Ctrl> + <A>.

The Front View is maximized now (figure 7).

gure 7

= Move your cursor to the centre of the Front View (bottom left) and Zoom in
(Scrollwheel up) till the sphere takes about 25% of the view. (figure 8).

itz

IS b v @310 NGl e AL NE)

figure 8

BlenderCourse - Basics v0.2.2 19



= Click on the brown box icon in the view menu bar and choose [Wireframe] (figure
9).

Draw type:
. Textured
@ shaded
£F solid

e

f Bounding Box

LEE

figure 9

In order to select multiple vertices we are using Block Select. You use block select by
pressing <B> while in Edit Mode. If you hold down your left mouse button, you can drag
a rectangle around the vertices. All vertices in this rectangle will be selected (yellow
coloured are the selected ones).

In Edit Mode you can press <A> to select or deselect all vertices.

=> Press <A> to deselect all vertices.

= Press <B> and drag a rectangle around all the vertices right from the centre-line
(figure 10).

4 Do not select the centre line itself, only the vertices on the right side of it!

lew Select Mesh | A Edimode <) | @] [@ =] [ &]0] = [clonal <]
figure 10

BlenderCourse - Basics v0.2.2
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This should be the result after your selection (figure 11).

< Fle Aui Tinelne Gane Render Help : Ve 248-384 | EG.457-2016 | Fa210-1024 | Men4.03M Sphere 001

figure 11

= Press <X>,

A menu appears (figure 12).

Edges

Faces
Kl

Edies & Faces
r Only Faces

figure 12

= Choose [Vertices].

You are now seeing half a sphere (figure 13).

|
" ie_asd_Tieirs_Gane_renc ot

210 [@ 1] FATo]= [sws =] 0] B 1] (2]

figure 13

= Press <Ctrl> + <¥> to see all view again. We continue working in the Front View.

= Select with <B> de rightmost row of vertices (marked red in figure 13).

BlenderCourse - Basics v0.2.2 21



= Press <E> for Extrude.

A menu appears (figure 14 or figure 15).

o Extrude

-] 2nly Edges
D Only Verices

figure 4

Individual Faces
Only Edges
Only Verices

figure 15

= Choose [Only Edges] or [Region].
= Press <X> to lock the X-axis.

= Move the mouse to the right.

In the bottom left of the view is displayed how for the “pill” is stretched (figure 16).

{13 Sphere 001

[: 1.3371 along global X

=+ = panels (@ |=|S|

figure 16

This number consists of a lot of decimals. To adjust till 3.0000 is quite hard.
= Press <ESC> to cancel the Extrude operation.
= Press again <E> - [Region].
= Press <3>.

The bottom left of the view menu bar shows 3 (figure 17).

D= 3] Dy: NOME Dz: MOME

figure 17

= Press <Enter> to accept the Extrude operation. You are now have half a pill
(figure 18).

BlenderCourse - Basics v0.2.2
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figure 18

In the Camera View (bottom left) you can see the pill is still hollow (figure 19).

| & Edit Moce S @ | RO © |3 |Glokal =)@

| & Edit Mode =] ' !_ @]= | Global =Ij§

figure 19

= Click in the view menu bar of Front View (bottom left) at [Mesh].

A menu appears (figure 20).

Scripts v
ShowtHide Verlices >
Proportional Fallom v
Froporional Editing o
Normals 5
Make EdgerFace
ot Edges v
vertices > Beauliy Fil
Delete X Comvert @uads 1o Triangles
Make Edge/Face F Conver Tangles ta Quads
Duplicate ShMD  Flip Triangle Edges
EHED E  setsmooth
Inser Keyframe | SetSolig
Snap v
Mirror 3
Transform v

O Multires Praperties.

O Transfarm Properties.
Transform Snap

Unda History

Redo Editing

Undo Editing

ot (0 Glalo[s [aoa <] ¢

FITon [a Tl em

figure 19 o

= Choose Faces - Fill (<Shift> + <F>).

The Camera View (bottom right) shows a “closed” pill now (figure 21).

BlenderCourse - Basics v0.2.2 23
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i .Mgéh' 4 Edit Mode :[‘.jf-} -._.Lgl @ o |Global :1,,
figure 21

= Save your work as bc02.01.blend (<Ctrl> + <W>).
The left part of our pill is ready, now we are continuing with the right part.

= Use <Ctrl> + Scrollwheel in the Front View for moving the pill to the left side of
the screen (figure 22).

w Select Mesh | AEditvoze <] |8 [@ {x] [BA]0 [0 [copa +
== T 1 1
figure 22

= Press <Tab> for Object Mode.
= Press <Shift> + <D> to duplicate the mesh.
= Press <Enter> to confirm the duplication.
The pill is now duplicated, but the duplications are still on top of each other.

= Press <R> for rotate.

=2 Type <1> <8> <0> to rotate the half pill 180 degrees and press <Enter>.

In the Front View there are two half pills over each other (figure 23).

ff §] ¥ View Select Ohject | Object Mode =] [0 3] |42 ¢+ RO |8 |Global & | P ] |

BEd v view semsct oect [Romsctone <] 199 Ola0 o [oova <] BHHHEHHE] @
figure 23
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=> Press <G> to move the mesh.
= Type <6> and press <Enter>.

The meshes are now tight together (figure 24).

figure 24

Figure 25 shows the red part of the pill is slightly bigger than the white part. We can
achieve this by using the scale method.

figure 25
= Select the right part of the pill.
= Press in the Side View (top right) <S> for scale.
=2 Type <1> <.> <1> and press<Enter>.

The Front View (bottom left) shows the right part bigger than the left one (figure 26).
Because of the scaling the two parts overlap each other.

figure 26

BlenderCourse - Basics v0.2.2 25



= Press <G> for move.
= Press <X> to lock the X-axis.

2 Type <0> <.> <3> and press <Enter>.

Materials

Blender uses materials. A material describes properties of a meterial such as color,
reflection, softness and structure. Course 5 describes materials in more detail.

= Select the right part of the capsule.
= Press <F5>.

The Material Panel appears (figure 27).

Qlc[ofa) = 1 ]
U me

figure 27
= Click at [Add New] to add a new material.

You have now added a new material. New Panels appear (figure 28).

figure 28

The materials preview is shown in the Preview Panel. The color of this object is grey. The
name is “Material.001".

= Click in the textbox which shows the name (marked red in figure 29) and change
Material.001 into Red.

nd Fipeline

figure 29

BlenderCourse - Basics v0.2.2 26
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Each colour consists of three primitive colours: red, green, blue.

2>

v vV Y

Drag the silders (marked red in figure 30) according to the following values: R at
1.0, G at 0.0 and B at 0.0.

Material

= [ wEal Light [ WCol Faint | TexFace | Shadeless |
| Motist | Eme [ ShadAl000 o
E = |R 1.000 —
G0.000 [
B0.000 —
[e] HEW | DY ][4 1000

figure 30

Now select the left part of the pill and make a material called “White” with the
values: Rat 1.0, Gat 1.0 and B at 1.0.

Select in the Top View (top left) the camera (marked red in figure 31). The
Camera View is shown in the bottom left view.

e =l [@:l[@ f:| [T = [ciona
figure 31

Press <G> to move the camera.
Move the camera in a so the whole pill is displayed in the Camera View.
Save your work (<F2>) as bc02.02.blend

Press <F12> to render your model. If everything worked out fine the image
should look like figure 32.

D Blender-Render
Fral Ve Fa:1276 Lac! Mem:12 82M {0.00M) Time:00.02.73

figure 32

BlenderCourse - Basics v0.2.2 27
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Everything looks serrated. Blender has a technique called smoothing. This makes your
object smoother. The “"smoother” your object, the longer it takes to render.

= Select the red part of the pill and press <F9> (Editing Panel).
Two Panels appear.

= Click [Set Smooth] (figure 33), this makes the mesh look smooth.

= Click [Auto Smooth] (figure 33), to autoset the smooth settings.

[ ]mEsphere | F |oB:Sphere | | Auta Smooth
Vertex Groups Red T Degran 7|
< 1 matl »
Mew Delete I Delete
- Select Deselect
Assign Remave
Select Desel. Assign WertCol tlake
TexFace| Make
Set Smooth | Set salid Sticky e

= Press <F12> to render.

You can see the red part is a lot smoother than the white part (figure 34).

40 Blender:Render
Fra:l Ve:! 442 Fa:1276 La:1 Mem:12.81 M (0.00M) Time:00:02 67

figure 34

= Select the white part.

= Make this part also smooth in the same way as we did with the red part.

=> Press <F12>.

Your pill should look smooth now (figure 35).
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= Save your work (<F2>) as bc02.03.blend

40 Blender:Render

Fra:l Vel 570 Fa:1276 La:1 Mem:12.81 M (0.00M) Time:00:02.54

figure 35

The challenge

0 Blender-Render

figure 36 - salt cellar - bc02.04.blend

Skills from this course

Recognising basic meshes

Vertex editing

“Smooth” objects

Entering coordinates manually
Naming and recognising Materials
Changing the Material color

BlenderCourse - Basics v0.2.2
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Appendix 1: The installation of Blender

This appendix provides a step by step guide about the Blender installation progress.

= Browse to http://blender3d.org/cms/Blender.31.0.html.

= Click under heading “2.42a"” on a mirror near you (marked red in figure 1).

2.42a

Platform Location

e

| NL USA 6 v
=% MS windows Installer, Python 2.4, AL Loa berman

98/ME/2000/XP (7.2 MB) —ns
figure 1
A window appears (figure 2).
File Download - Security Warning

Do you want to run or save this file?

Mame: blender-2.42a-windows . exe
Type: Application, 7.20 ME

Fram:  mirror.cs.umn, edu

Bun Save i LCancel

P ‘While files from the Intermet can be useful, this file type can
o patentially harm your computer. If you do not trust the source, do nat
Tun of save this software. What's the risk?

figure 2

= Choose [Run].

= The installer is now being downloaded (figure 3).

62% of blender-2.42a-windows.exe Completed =[O x]

- =
Cpening:

blender-2, 42a-windows, exe From mirror,cs,umn. edu

Estimated time left 12 sec {(4.41 ME of 7.20 ME copied)
Download to: Temporary Folder
Transfer rate: 225 KBJsec

¥ iCloze this dialog box when downioad completes

Mpen Open Eolder | Cancel I

figure 3

When the file is downloaded successfully a security warning appears (figure 4).

Internet Explorer - Security Warning [ x]
The publisher could not be verified. Are you sure you want to run this
software?

Mame: blender-2.42a-windows exe

Publisher: Unknown Publisher

This file does not: have a valid digital signature that verifies its publisher, You
should only run software from publishers you trust, How can I decide what
software ko run?

figure 4

= Choose [Run].

BlenderCourse - Basics v0.2.2 30
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The installation process starts.

= Click on [Next >] (figure 5).

Welcome to the Blender 2.42a
Setup Wizard

This wizard will guide you through the installation of Blender.

Itis recommended that you dose all other applications
before starting Setup.

Note to Win2k/XP users: You may require administrator
privileges to instal Blender successfuly.

Cancel I

figure 5

= Click on [I Agree] (figure 6).

=

Agreement

— License
;@ blender Please review the license terms before instaling Blender 2,42a.

Press Page Down to see the rest of the agreement.

-
This version of Blender has been originally released at www blender.org, :I

Itis subject to the GPL license, which is part of this download.
For more information please review the Blender source code distribution,
which should be available at the same location as where you obtained

this version.
IMPORTANT: PLEASE READ CAREFULLY BEFORE USING THE BLENDER SOFTWARE

This License Agreement for the Blender software (License
Agreem;nt’) is an agragmeptget\ﬁ'een_Sh:hu:ng_Blender F_our_\daﬁon, LI

If you accept the terms of the agreement, dick I Agree to continue. You must accept the
agreement to install Blender 2.42a.

hitbp: e blender, aray ok

< Back I I Agree I Cancel

figure 6

= Click on [Next >] (figure 7).

=

- Csae Conponert
@ blender Choose which features of Blender 2.42a you want to install

This will install Blender 2.42a on your computer,

lends 23 i
dd Start Menu shortouts
dd Desktop Blender-2.42a shortcut
pen .blend files with Blender-2.42a

Select components to install:

Description
Positinn /Gur mouse over & component ko ses its

Space required: 16.7MB
descriptian.

hitbpe v blender, oray bk

< Back I Next > I Cancel

figure 7
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If necessary you can pick the folder in which Blender needs to be installed. If you do not
know what to do just leave the default location.

= Click on [Next >] (figure 8).

& Blender 2.42a Installer =] 3]
Choose Install Location
e blender Choose the folder in which to instal Blender 2,42a.,

Use the field below to specify the folder where you want Elender to be copied to. To specify
a different folder, type a new name or use the Browse button to select an existing folder.

Browse. ..

"Deshnahun Folder

Space required: 16.7MB
Space available: 18.1GB

hitbpe v blender, oray bk

< Back I Next > I Cancel

figure 8

= Click on [Install] (figure 9).

& Blender 2.42a Installer =] 3]

Specify User Data Location
e blender

Please spedfy where you wish to install Blender's User Data files,

€ Hse Application Data Directory (Win2k/XP only)!
&+ Use Installation Directory (ie. location chosen to install blender . exe).

I have defined a 2%HOME®% variable, please install files here.

hitbpe v blender, oray bk

< Back I Install I Cancel

figure 9

File files are now being copied to the harddisk (figure 10).

& Blender 2.42a Installer ] 3

Installing
¢ blender Please wait while Blender 2.42a is being installed.,

Extract: object_batch_name_edit,py... 100%

]

{"Show details

hitbpe v blender, oray bk

< Back [dext > Cancel

figure 10

|
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= Click on [Finish] to start Blender (figure 11).

& Blender 2.42a Installer =101=]

Completing the Blender 2 42a Setup
Wizard
Blender 2.42a has been installed on your computer,

Click Finish to dose this wizard.

¥ Bun Blender 2,435

< Back I Einish I Cancel

figure 11

Blender will be started for the first time (figure 12).

figure 12

The installation is finished. To follow the lessons of BlenderCourse some settings need to
be adjusted. These are described in "Appendix 2 — Configure Blender”.
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Appendix 2: Configure Blender

This appendix helps you to configure Blender in a way you can work with comfortably. If
after these steps, you do not get it, you can use the “"B.blend” file from this course file.
Copy this file in the subfolder “.blender” of your Blender installation folder (e.g.
C:\Program Files\Blender Foundation\Blender). But I still recommend you to follow the
steps below to get familiar with the Blender environment.

When starting Blender you can see our screen consisting of three parts: menu bar, a

window with a centred square and a window with some buttons. These windows are
called “Panels”.

The square is the top view of a cube. For easy 3D modelling we like to have multiple
views. These views are: front-view, top-view, side-view and camera-view.

The next steps will guide you into how to create these views.

= Click with the right mouse button on the border between the panel containing the
cube and the bottom panel (red spot in figure 1).

A menu appears (figure 1).

14 Object |

Mo Header
[ =[ME:Cube [F[OB:Cube

figure 1
= Click with the left mouse button on [Split Area].

= Move with the cursor to the centre of the cube. You see a vertical line following
your cursor (figure 2).

= Click with the left mouse button as soon as the line intersects with the centre of
the cube.

figure 2

Now you are having two views next to each other. Both views show the top-view of the
cube (figure 3).
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figure 3

Right now we have two views, but initially we want to have four. To make four views we
have to split up each view again.

= Click with your right mouse button on the border between both views (red spot in
figure 4).

Another menu appears (figure 4).

= Click with your left mouse button on [Split Area].

Split Area
Jaoin Areas
o Header

figure 4
Again there is a line which splits the views.
= Move your mouse cursor to the centre of the right view.
= Click with your left mouse button to confirm the split-up.

Now you have three views each representing the cube’s top-view (figure 5).

m.x [#o s | BN 0 [ (e =] EFECE I a1

figure 5
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= Click with your right mouse button on the vertical border in the centre of your
screen (red spot in figure 6).

Jaoin Areas

o Header

{13 Cube

& ¢ = wview select DbjectE

figure 6

= Choose [Split Area].
= Move your mouse cursor to the centre of the left view.

= Click with the left mouse button to confirm.

If everything worked out well you have four views (figure 7).

W0l [ooe )

Gt s (o< LT HG) (@]

figure 7
All the four views are top-views now, in the next steps we are about to change this.

There is a menu bar located under each view (figure 8). With this menu you can adjust
several settings for this view.

| ¢ =[view | select Object |12 object Mode < | [ 2| (@ <[] [H[AT O] [Global +| FHHH

figure 8
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= Click in the menu bar of the bottom left view on [View] (marked red in figure 8).
A menu appears (figure 9).

= Click on [Front].

Space Handler Scripts

Flay Back Animation

Maximize Window Ctrl UpArrow
View All Home
View Selected MNumPad

Align Wiew

Wiew Navigation

Global View

Local View

Orthographic

Perspective

Site

Top
Camera
User

3 Background Image..

The view has been changed from top-view into front-view (figure 10).

Le[sme-motel  [x][c[sceseene xS

[onjctvove <] S EI O &lo[= [awwa 2]

]~ View Selct_Obict [E0ectoce 5] (9] o = [cua 3]

Material

WETTen
Mew, Delete.

Booot | Deseect |y [ Contre v |

tre Cursor

figure 10

= Now click on [View] in the menu bar of the top right view and choose [Side]
(figure 11).
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QD select Object [ Onject Mode =

O Render Preview.

0 View Properiies
O Background Image.

User
Camera
v Top
nt

Perspective

Orthographic

Local View

Global View

Wiew Navigation

Align View

Set Clipping Barder

Wiew Selected

Wiew Al

Maimize Window  Chrl UpAmow
Play Back Animation Alt &

Modifiers Space Handler Scripts »

1 Moifier To: Cube

figure 11

Your screen should look like figure 12.

P =[E
| 2 [she-model [ ][ c[scEscens % i

O 500 3] oot objat | oufec vt _2) o - [oo:a <)M 11

12 Object Mods

e Delete |
Setct | Desdect | e
: (ot Grsor

figure 12

We are now going to adjust the bottom right view.

= Click on [View] in the menu bar of the bottom right view and choose [Camera]
(figure 13).
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Space Handler Scripts »

Play Back Animation Alt &
| Maximize Window  Ctrl Uparrow|

View Al

View Selected

Set Clipping Border

Align View

View Navigation

Global View

Local View

Otthographic

Ferspective

side

5 Background Image.
O view Properties

All views are now properly adjusted. The top left view does not need any adjustment
since it is already displaying the top-view. Your screen should look like figure 14 (the
names of the views are displayed in the red boxes).

SIDE

12 Object Mode 12 Object Mode [©]= [ciopal_ 2]

CAMERA

{ ube
| = view Select Object |% Object Mode = I_@ & [Giobal 2| FFHH

ertex Groups. Material

Mew
Select Mltires|_Make_|
Assign VertCol| Make |
:  TexFace]_Moke | [SlowerDra 5
[Get Smooth[ set soid | stioky | Mako | [ FasterDra

gure 14
Because we do not want to do previous instructions every time we start Blender we are
going to save them as default.

= Click on [File] which is located on the top left of your screen and choose [Save
Default Settings] (figure 15).

You do not get any message about this saving.
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El Add Timeline  Game Render Hely
Cirl %

Verse 3
Open Recant 3
Recover Last Session

Save Cirl W
Save As Fz
Compress File

Save Image F3
Durp Subswindow CtrlF3
Dump Screen Ctrl Shift F3
Save Runtime

Save Dynamic Runtime.

Cirl U

Default Settings
AppendiLink Shift F1
Import »

Export
Pack Data
Unpack Data.

Guit Blender

figure 15

The settings are now saved as the standard settings for each new scene.
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Appendix 3: Key overview

Object Mode

<G> > <X>
<G> > <Y>
<G> > <Z>

<S> > <X>
<S> > <Y>
<S> > <Z>

<R> > <X>
<R> > <Y>
<R> > <Z>

<Ctrl> + <>
<Ctrl> + <V >

<Alt> + <C>
<Alt> + <A>

<Ctrl> + <W>
<Ctrl> + <O>

<F1>
<F2>
<F3>
<F5>
<F6>
<F9>
<F11>
<F12>

<Alt> + <Scrl>
<Ctrl>+ <Scrl>
<Shift> + <Scri>

Move over X-axis
Move over Y-axis

Move over Z-axis

Scale on X-axis
Scale on Y-axis
Scale on Z-axis

Rotate over X-axis
Rotate over Y-axis
Rotate over Z-axis

Maximise view

Back to previous size

Convert object type
Playback Animation

Save
Open last used file

Open

Save as

Save render
Shading Panel
Texture Panel
Editing Panel
Show latest render

Render scene

Zoom view in and out
Move view horizontal

Move view vertical
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<Q>
<X>

<N>

Edit Mode

<A>
<B>
<E>
<0O>

<Shift> + <F>

Quit Blender
Delete
Transform Properties

Insert Keyframe

Select or deselect all vertices
Block selection

Extrude

Proportional Editing

Face Fill
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Appendix 4: Blender gallery

SpeedTiti
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SpeedTiti

Malefico Andauer

“Fairy Lover" - (c)2005 - mal@&F

codd.com.ar
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Zoltan Miklosi

Bas van Dijk

More images can be found at http://blender3d.org/cms/Images.151.0.html.

All images are copyrighted by their owner. BlenderCourse has explicit permission for using these images from
their owners. These images are not allowed to be copied or whatsoever. Contact the owners if you want to use
them.
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